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The NetWare Tools provide you with a graphical way of accessing network resources, such as
volumes, directories, printers, and users. They also allow you a way to configuring your 
workstation and customize NetWare Tools display settings. 
Note: To learn how to use Help, press <F1> or choose "How to Use Help" from the "Help" menu. Use the scroll bar 
to see more entries.
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Quick keys

Tools
Drives
Printers
Connections
Messages
Settings
Properties
User Defined Buttons

How to...
Allow or Block Incoming Messages
Log In to NetWare Directory Services Resources, Bindery Servers, or Workgroups
Change a Password
Connect a Drive
Connect a Print Queue
Log Out of NetWare Directory Services Resources, Bindery Servers, or Workgroups
Disconnect a Drive
Send a Message to a User or Group
Make a Drive Mapping Permanent
Set Hotkey
Set Print Manager Display Options
Set Printer Options
Set Resource Display Options
View Effective Rights
View NetWare Information

Note: Changes made with NetWare Tools will be reflected in your NETWARE.INI, WIN.INI, and SYSTEM.INI files.



Drive Connections
NetWare Drive Connections let you:

View your effective rights
Set a drive mapping permanent
Connect and disconnect drive mappings

How to...
View Effective Rights
Make a Drive Mapping Permanent
Disconnect a Drive
Connect a Drive
Change Map Root

Screen regions and buttons
"Drive Info" Activates the information window that displays the effective rights for a 

drive.
"Permanent" Makes a drive mapping permanent within Windows.
"Map Delete" Allows you to disconnect a resource from a network drive.
"Map" Allows you to connect a resource to a specific network drive.
"Path" Specifies the volume and directory path for a drive.
"Drives" Lists drive letters and mappings.
"Resources" Lists the available NetWare Directory Services, bindery, or Personal NetWare

directory map resources to which your workstation is logged in and has appropriate 
rights.
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Change Map Root
The map function sets the resource you map as a root for the drive you choose. This 
establishes the map root for the drive mapping. You can change the map root as follows:
1. Select the drive mapping you want to change from the "Connections" list.

This will highlight the drive mapping and display it in the "Path" field.
2. Choose the arrows to the right of the "Path" field to change the map root.

The drive path will separate, leaving a space between the map root and the remaining directories.
Note: Your drive mapping will still be set to the directory you originally mapped to, however you can move up 
and down the directory structure from the root.



Map Root
A Map Root is the highest directory level in a hierarchical directory structure. When the map 
root is set, all directories below the root become subdirectories of the root. You are not able 
to access directories higher in the directory structure than your map root. NetWare maps 
each drive mapping as the root for each network drive.



View Effective Rights for a Directory
To view your effective rights
1. Choose "Drive info."
2. Choose "OK."

Screen regions and buttons
"Server" Displays server name, NetWare version, and number of users supported.
"Path" Displays current drive path.
"Username" Displays your username on this server.
"Effective rights" Lists the rights you have in this directory.
"OK" Closes the "Drive Info" window.



Effective Rights
The total rights supported on your network are:

S Supervisor
R Read
W Write
C Create
E Erase
M Modify
F Scan
A Access Control



Map a Drive
To map a drive
 1. Select the resource to which you want to map a drive from the "Resources" list.

If the resource you want is not available, make sure you are connected to the NDS resource, bindery server, or 
workgroup containing these resources.

2. Drag the resource to the desired drive and drop it or choose the drive letter you want to use from the 
"Drives" list.
Browse down a level by choosing the resources name.

3. Choose "Map" if you did not drag and drop.
The drive is mapped. You can make it permanent by choosing the permanent button.



Disconnect a Drive
To delete a drive mapping
1. Select the drive you want disconnected from the "drives" list.
2. Drag the drive mapping to the resources field and drop it or choose "Map Delete."

The drive mapping is deleted. You can now assign a new mapping for the drive.



Make a Drive Mapping Permanent
To make a drive mapping permanent
1. Select the mapping that you want to make permanent.
2. Choose "Permanent."

A drive icon will appear to the left of the drive letter.
Note: Choose the "Permanent" button again to make the setting non-permanent. 
Note: Make sure that the "Permanent Connections" box in "NetWare Settings" is marked when using this feature.



Printer Connections
NetWare Printer Connections let you:

Set printer options
Make a print queue connection permanent
Connect and disconnect a print queue

How to...
Set LPT: Settings
Make a Print Queue Capture Permanent
Disconnect a Print Queue
Connect a Print Queue
Set up Workstation Printing

Screen regions and buttons
"LPT: Settings" Lets you set printer options.
"Permanent" Sets a print queue to a specific port.
"End Capture" Allows you to disconnect a print queue from a port.
"Capture" Allows you to connect a print queue to a port.
"Queue" Specifies the queue.
"Ports" Lists available ports.
"Resources" Lists available print queues.
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Set Printer Options
Set options
1. Choose "LPT Settings."
2. Make changes to your options.
3. Choose "OK."

Options
"Hold" Holds print files in the print queue until you choose to resume printing.
"Notify" Provides a confirmation of print job completion.
"Formfeed" Places a page break between print jobs.
"Auto endcap" Specifies that the captured printing jobs be closed 
"Direct" Sends the print job directly to the printer.
"Copies" Specifies the number of copies to print.
"Enable Tabs" Specifies the number of characters in a tab stop.
"Enable Timeout" Specifies the amount of time before the print buffer is closed and sent 

to a printer.
"Enable Banner" Allows for a banner page to be printed at the front of your print job.
"Form Name" Allows you to select a defined print form.



Hold
Holds print files in the print queue until you choose to resume printing. To release the print 
file, select the print job you want to resume in Print Manager and choose "Resume."



Notify
Informs you that your data was printed. It does not notify you if the printer has a problem or 
cannot print the job.



Formfeed
Instructs the printer to place a page break between print jobs.



Auto endcap
Enable this option if you want print jobs sent to a network printer or file when you exit or 
enter an application. It is useful if you want to hold printing of several files until you exit the 
application.



Direct
If there are no jobs resident, your print job will bypass the print queue (Personal NetWare 
only).



Copies
Indicates how many copies to print.

Default: 1
Maximum: 255
Minimum: 1



Enable Tabs
Specifies the number of characters in one tab stop. Choose this box if your application does 
not have a print formatter (most applications have a formatter).

Default: 8
Maximum: 18
Minimum: 1



Enable Timeout
Maintains an open spooling file in the queue for the amount of time you set. This allows for 
print jobs with multiple entries or files to be printed on the same page or same output.
When the first bit of data is sent to the queue, a spooling file is opened and will remain open
as long as data is received within the amount of time you set.
After the last bit of data is received, the spooling file will remain open for the amount of time
that you have set before closing. After closing, the spooling file is sent to the printer.

Default: Disabled (0)
Maximum: 1000 (seconds)
Minimum: 0 (seconds)



Enable Banner
Specifies the text on the banner page. Enter the text you want to appear in the banner text 
fields.

Default First Banner name: (Username)
Default Second Banner name: (LST:)



Form Name
Specifies the form on which to print your print job. Use the "Printer Form" page in NWADMIN 
to define forms for User objects and Container objects for NetWare users. Use PNWADMIN for
Personal NetWare to define forms for workgroups and users.



Make a Print Queue Capture Permanent
To set a printer connection
1. Select the port that you want to make permanent.

If a print queue is not captured to a port, capture a print queue first before you proceed.
2. Choose "Permanent."

A printer icon will appear to the left of the port.
Note: Choose the "Permanent" button again to make the setting non-permanent. 
Note: Make sure that the "Permanent Connections" box in NetWare Settings is marked when using this feature.



Connect a Print Queue
To connect a printer port to a queue
1. Select the print queue you want captured from the "Resources" list.

If the print queue you want connected is not available, make sure you are connected to the NDS resource, 
server, or workgroup containing these resources.

2. Drag the print queue to the desired port and drop it or choose the port name (LPT:) you want 
connected from the "Ports" list.

3. Choose "Capture" if you did not drag and drop.
The port is captured. You can make it permanent by choosing the "Permanent" button.



Disconnect a Print Queue
To disconnect a printer connection
1. Select the port you want disconnected from the "Ports" list.
2. Drag the print queue to the resources field and drop it. Choose "End Capture" if you did not drag and 

drop.
The printer connection is terminated. You can now assign a new capture for the port.



Setting Up Workstation Printing
Setting up workstation printing in Windows requires you to complete the following steps:

Activate the Print Manager.
Install a printer driver.
Assign printing ports to network print queues.
Capture print queues to a port.
Enable print jobs to be sent directly to a network queue.

Advanced Set Up
Network Printer on a Windows Workstation
Set number of printer ports available



Network Printer on a Windows Workstation
For network access to a parallel or serial printer cabled to a workstation running Windows 
v3.0 or v3.1, do only one of the following:
1. Configure the printers to use polled mode instead of a specific interrupt number.
2. Insert the following lines in the SYSTEM.INI file under the heading "[386Enh]"

LPT1AutoAssign=0
LPT1irq=-1
Replace LPT1 with the port that the printer is cabled to (LPT2, COM1, COM2, etc.).
This sets the workstation to use a specific interrupt.



Set Number of Printer Ports Available
1. Set the "NetWare Printer" setting to the number of printer ports you want made available.

This setting is made under the "NetWare DOS Requester" option in your workstation NET.CFG file. You can set 
up to nine ports. For example:
NetWare DOS Requester

Network Printers = 9
2. Edit the [ports] option in your WIN.INI file for the number of printer ports you want 
displayed. For example:

LPT1:=
LPT2:=
LPT3:=
LPT4:=
NET1:=
RECORD.PRN=

Note: Add a filename to a line under the [ports] option to have print files print directly to this file.The file name 
should have a .PRN file extension followed by an equal sign. This will cause the [filename] to appear in the Control 
Panel's "Printer Configuration" dialog box. A printer connected to [filename] directs its output to this file.



To activate the Print Manager
1. In the Windows Control Panel, choose the Printer icon.

The "Printers" dialog appears.
2. Mark the "Use Print Manager" box.

The Print Manger is activated.



To install a printer driver
1. Select a printer driver from the "Installed Printers" list.

If the printer driver already exists, go to "Assign printing ports to network print queues."
2. Choose "Add" to display the list of available printer drivers.
3. Select a printer driver from the "List of Printers" for your network printer.
4. Choose "Install."

Windows prompts you to insert a Windows diskette and then copies the selected printer driver to the Windows 
directory.



To assign a printing port to network print queues
1. Choose "Connect."

The 'Connect" dialog appears.
2. Select a port from the "Ports" list.

If you have a local printer, it is recommended that you leave it assigned to the port to which it is already 
connected.

3. Choose "Network."
The "NetWare Printer Connections" window appears.



To capture print queues to a port
1. Select the same port from the "Ports" list that you selected in "To assign a printing port to network 

print queues."
2. Select a print queue name in the "Resources" list.

If the print queue you want connected is not available, make sure you are connected to the NDS resource, 
bindery server, or workgroup containing these resources.

3. Choose "Capture."
4. Exit the "NetWare Printer Connections" window.

Your screen will return to the "Connect" dialog.
5. Choose "OK."

Your screen will return to the "Printers" dialog.
6. Choose "Close" to exit the "Printer" dialog.



To enable print jobs to be sent directly to a network print queue.
1. Choose the "Print Manager" icon.

The "Print Manager" window appears.
2. Select the "Options" option.

The "Options" menu appears.
3. Choose "Network Settings."

The "Network Options" dialog appears.
4. Enable the "Print Net Jobs Direct" option.

With this option marked, Windows bypasses the Print Manager and prints directly to the network print queue, 
giving you optimal printing performance.



NetWare Connections
NetWare Connections let you do these four things:

- View individual server information
- Change login passwords
- Detach network connections
- Attach network connections

How to...
View NetWare Information
Change Password
Log Out of NetWare Directory Services Resources, Bindery Servers, or Workgroups
Log In to NetWare Directory Services Resources, Bindery Servers, or Workgroups
Change Current Server Connections

Screen regions and buttons
"NetWare Info..." Activates "NetWare Info" displaying information about network servers.
"Set Pass..." Lets you change your password.
"Logout" Allows you to detach from network resources.
"Login" Allows you to attach to network resources. Logs in without running a login script.
"Contexts" Allows you to change your current context.
"Connections" Lists the network resources to which you are currently connected.
"Resources" Lists the available NDS resources, servers, and workgroups.
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Change Current Server Connections
The "*" symbol to the left of a connected server notifies you of the current server setting. 
The current server is used to maintain the "Resources" list by retrieving available resources 
in the network specific to the server's dialog setup.
If the current server is restricted and cannot display all the available resources, such as a 
router, use this feature to change your current server to a server which will display available 
resources for your network. To change the current server connection, hold the <Ctrl> key 
and choose the server you want set as your current server.



Login to NetWare Directory Services Resources, Bindery Servers, or 
Workgroups
To log in
1. Select the resource you want to connect to from the "Resources" list.

Note: If you are using NetWare Directory Services, change to your name context. If your context is not shown, 
mark the "DS Containers" option in "NetWare Settings" window to display container objects. Use the parent 
container arrow or choose the Container object to browse the tree.

2. Drag the resource icon from the "Resources" list and drop in the "Connections" field or choose 
"Login" if you did not drag and drop.

3. Type your username and password, if prompted.
4. Choose "OK."

An icon will appear in the "Connections" list when you are successful.



Log Out of NetWare Directory Services Resources, Bindery Servers, 
or Workgroups
To log out
1. Select the resource you want to log out from.
2. Drag the resource icon from the "Connections" list and drop in the "Resources" field or choose 

"Logout" if you did not drag and drop.
You are detached from the resource.
Note: All of the group and user resources for the detached resource will not be available. Drive mappings 
associated with this resource will be disconnected.

Note: If you want only to clear a connection, hold down the <Alt> key then choose "Logout." The server icon and 
name will still be displayed in the "Connections" list.



Change password
To change your password
1. Select the resource from the "Connections" list which you want to change the password.
2. Choose "Set Pass."
3. Type your current password in the "Old password" box.
4. Type your new password in the "New password" box.
5. Retype your new password in the "Retype new password" box to verify your new password.
6. Choose "OK."



View NetWare Information
To view NetWare information
1. Choose the "NetWare info" button.

The NetWare Info window for a connection appears.
2. Choose "OK."
Screen regions and buttons

"Server Name" Shows the name of this server.
"Server Version" Shows the version of NetWare this server is running.
"Login Name" Shows the name you used to log in.
"Connection ID" Shows your current connection identification number.
"Connection Type" Current type of connection. These can be:

Preferred
Primary
Current
NetWare Directory Services Authenticated
NetWare Directory Services Non-Authenticated
Bindery Authenticated
Bindery Non-Authenticated
Personal Authenticated

Personal Non-Authenticated



NetWare Send Message
NetWare Send Message lets you send messages to groups and users.
How to...

Show or Hide Group Resources
Show or Hide Users Resource
Send a Message to a Group or User

Screen regions and buttons 
"NetWare Info" Displays information about the server.
"Show/Hide Groups" Shows or hides group names in the "Resources" list.
"Show/Hide Users" Shows or hides user names in the "Resources" list.
"Send" Allows you to send a message to groups and users.
"Message" Allows you to enter your message.
"Connections" Lists the resources to which you are logged in.
"Resources" Lists the logged in group and user names.
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Show or Hide Group Resources
To show group resources
Choose "Show Groups."
To hide groups resources
Choose "Hide Groups."



Show or Hide User Resources
To show users resources
Choose "Show Users."
To hide users resources
Choose "Hide Users."



Send a Message to a Group or User
Note: Make sure you are attached to the server to which the users or groups are attached.
1. Select the resource that the users or groups you want to send a message are logged in to.
2. Select the user or group that you want to send a message.

If the user or group you want to send a message is not available, make sure you choose the server these 
resources are connected to.

3. Type your message in the "Messages" box.
4. Choose "Send."
Number of Characters allowed

Personal NetWare/Bindery: 57 characters including your username and connection ID.
NetWare Directory Services: 256 characters including your username and connection ID.



NetWare Settings
NetWare Settings provide you with a graphical way of:

Setting permanent connections to restore when loading Windows
Setting message reception on or off
Setting Print Manager and resource display options
Changing the hotkey value

How to...
Enable Permanent Connections
Allow or Block Incoming Broadcast Messages
Enable or Disable Display of Network Warnings
Set Print Manager Display Options
Set Resource Display Options
Set Hotkey

Screen regions and buttons 
"Permanent Connections" Restores resource connections made permanent the next time 

you load Windows.
"Message Reception" Allows you to enable or disable broadcast messages and network 

warnings.
"Print Manager Display Options" Allows you to set the number of print jobs displayed in 

"Print Manager."
"Resource Display Option" Allows you to select the resources you want displayed in the 

"Resources" list.
"NetWare Hotkey" Allows you to enable and change the hotkey value.
"OK" Saves changes for permanent use.

Keyboard
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Allow or Block Incoming Broadcast Messages
To allow or block broadcasts
Mark the "Broadcasts" box.

 If you unmark the "Broadcasts" box, incoming messages are lost. You cannot access them later.



Enable or Disable Display of Network Warnings
To enable display network warnings
Mark the "Network warnings" box.

Disabling this option will stop display of load time errors.



Set Print Manager Display Options
To set maximum jobs and update seconds for print jobs displayed in Print 
Manager
1. Choose the scroll arrow in the "Maximum Jobs" option to increase or decrease the number of jobs 

displayed in "Print Manager."
2. Choose the scroll arrow in the "Update Seconds" option to increase or decrease the number of 

seconds before the "Print Manager" display list is updated.



Set Resource Display Options
Setting a resource display determines the database type listed in the "Resources" list. You 
can also select to display NetWare Directory Services objects and containers. There are three
database types supported:
Bindery (NetWare v2.x and v3.x)
Personal NetWare (Distributed Object Database)
NetWare Directory Services v4.0 (NDS)

To display network resources in the resource lists
Options
Bindery Select "Bindery" to display bindery resources.
Personal Select "Personal" to display Personal NetWare resources.
DS Objects Select "DS Objects" to display Directory Services Objects resources.
DS Containers Select "DS Containers" to display Directory Services Containers.

Mark this option in order to change your context. This will display Container objects within the Directory tree.
Name Sort Select "Name Sort" to display resources alphabetically.
Type Sort Select "Type Sort" to display resources by type.



Bindery Resources
A bindery resource is any entry maintained in a NetWare v2.x or v3.x bindery. It can also be 
a Bindery object within a NetWare v4.0 network.
The NetWare bindery differs from the NetWare v4.0 database in that bindery supports the 
operation of a single NetWare server or a flat-file database. Netware Directory Services 
(NDS) supports an entire network of servers. So, instead of storing all information on a single
server, information is distributed over a global database, and accessed by all servers.
Objects in a bindery exist in a flat database instead of a hierarchical database like a 
Directory tree. NetWare v4.0 provides compatibility with bindery-based versions of NetWare 
that may co-exists on your network through Bindery emulation.
Bindery emulation occurs when NetWare Directory Services (NDS) "emulates" a flat structure
for the objects. All objects within a specific Container object can then be accessed both by 
NDS and bindery-based clients and servers. The Container object where bindery emulation is
set is called the Bindery context.



Personal Resources
A Personal resource is any entry such as servers, printers, drives, users or groups 
maintained in a Personal Distributed Object Database. This is the database structure used by
Novell's Personal NetWare. NetWare Tools supports NetWare v4.0, v3.x, v2.x and Personal 
NetWare. Personal NetWare is a peer-to-peer network developed by Novell, Inc.
Note: If you do not have Personal NetWare running on your workstation, the "Personal" option will not be available 
for selection.



DS Objects
NetWare Directory Services (NDS) objects are network resources such as Users, Servers, 
Groups, Printers, Volumes, and others that reside in the Directory tree.
Each object consists of information within its properties. Some objects represent physical 
entities. For example, a User object represents a network user, and a Printer object 
represents a printer. Some objects represent logical entities, such as groups, and print 
queues.



DS Containers
An NDS container object contains other objects. The most common containers are:

Country (C=)
Organization (O=)
Organizational Units (OU=)

Choose the Container object you want to browse in order to display the resources residing in 
that Container.



Enable Permanent Connections
Enabling the Permanent Connection option will allow you to restore all of your resource 
connections marked as permanent. NetWare Tools will prompt you to re-establish any drive 
and port connections you made within Windows the next time you load Windows at your 
workstation if the connections do not exist already.
Note: You must mark the "Permanent Connections" box in order to enable permanent connections made within the 
"NetWare Drives Connections" and "NetWare Printer Connections" windows to restore next time you load Windows. 
If you unmark the "Permanent connections" box, a memory of your permanent connections will be kept.



Set Hotkey
To enable the hotkey
Mark "Enable hotkey" option.

If this option is not marked, you can't use the hotkey.
To set the hotkey value
1. Press the key you want to be your new hotkey.
2. Choose "OK."

Note: The default setting for is <F6>. The hotkey value for takes first priority over other application hotkey 
assignments.

Important: Using the same key value in other Window's programs as the hotkey value will load "NetWare Tools." You should use 
the icon if there may be a conflict.



Changing Attributes
To access properties and change attributes
1. Access "File Manager."
2. Select the files or directory for which you want to set attributes.

This function applies only for files and directories on network drives.
3. Choose the "Properties" option from the "File" menu.
4. Choose "NetWare" in the "Properties" window.
5. Select the appropriate box to enable or disable an attribute.
Note: If you don't have rights to change properties, all of the options will be greyed out. If only some of the options 
are greyed, the greyed options are not supported by your version or type of NetWare.

Options
Sharable Allows users simultaneous access to files or directories.
Transactional Indicates that files and directories are protected by TTS.
Purge Notifies NetWare to purge files or directories when it is deleted.
Rename Inhibit Prevents users from renaming files or directories.
Delete Inhibit prevents users from deleting files or directories.

Copy Inhibit prevents users from copying files or directories (Macintosh workstations 
only).



Sharable (S)
Allows files and directories to be accessed by more than one user at a time. It is usually used
with the Read Only attribute.



Transactional (T)
Indicates that files and directories are protected by TTS (Transactional Tracking System). TTS
prevents data corruption by ensuring that either all changes are made or no changes are 
made when files and directories are being modified.



Purge (P)
Tells NetWare to purge files and directories when they are deleted. The files and directories 
cannot be salvaged.



Rename Inhibit (R)
Prevents a user from renaming files and directories.



Delete Inhibit (D)
Prevents any user from deleting files and directories.



Copy Inhibit (C)
(Valid only on Macintosh workstations.) Prevents users from copying files and directories.



Using the User Defined Buttons "1" and "2"
The "1" and "2" buttons allow you to load additional programs. This can be very useful for 
accessing applications, such as, Windows' File Manager and Print Manager.
To define a button
1. Open the "User Defined Path" dialog.

You can open the "User Defined Path" dialog in the following two ways:
a. Choose the "1" or "2" button, if no previous path is defined.
b. Press <Alt><1> or <Alt><2>.

2. Type the path and program filename in the "Command Line" field. For example, type:
C:\windows\winfile.exe

This will define the Windows File Manager to load from NetWare Tools.
3. Choose "OK."



Quick Key Menu
Exit <Alt><X>
Drive Connections <Alt><D>
Printer Connections <Alt><P>
NetWare Connections <Alt><C> 
Send Messages <Alt><M>
NetWare Settings <Alt><S>
Help <Alt><H>
User Define 1 <Alt><1>
User Define 2 <Alt><2>
Note: Each time you select a menu option, the corresponding button will depress or a dialog box appears. If an 
option is grayed, that option is not active or available.
All connections can be made by choosing the corresponding button or drag-and-drop. 



Restoring Permanent Connections
The "Restoring Connections" window allows you to manage conflicts between existing 
network resource connections made in DOS and connections set as permanent in Windows.
Note: You must mark the "Permanent Connections" box in "NetWare Settings" to enable permanent settings made 
within the "Connections" windows to restore next time you load Windows.

Screen regions and buttons
"Restoring Connections" Lists the network resource connections which were marked as 

permanent in the previous Windows session.
"Status" Displays the results of your network connections after restoration and 

management for each connection is completed.
"Force" Disables prompt for restoring network resource connections that conflict with 

existing connections.
"Skip" Skips the highlighted connection in the "Restoring Connections" list. This 

connection will be invalid.
"Continue" Restores the highlighted connection. This will override the pre-existing 

connection made in DOS.
"Remove" Deletes the highlighted resource connection setting.
"Cancel" Stops restoration of permanent settings and exits the "Restoring Connections" 

window.
"Help" Displays online documentation.


